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1. Current Interrupt in ChronoPotentiometry. 

 

The Current Interrupt Module (CIM) can be used during ChronoPotentiometry. In 

Advanced mode, the parameter "CI at Level[2]" was added. When checked, it will 

activate a Current Interrupt during the 2nd level.  

 

 

2. Voltammetric Pulse Builder 

 

To the group of ElectroAnalysis techniques the 

Voltammetric Pulse Builder has been added. 

With this technique (new) Voltammetric Pulse 

Techniques can be defined to user 

specifications. All existing techniques, such as 

DPV, NPV, DNPV, SQRWV, etc, can be compiled 

with this tool. Moreover newly proposed pulse 

waveforms can be constructed and tested, in a 

very flexible and user-friendly manner, without 

the loss of performance. Pulse patterns can be 

defined with 0.02ms resolution, with each pulse 

as short as 1ms. 

 

 

 

 

The Voltammetric Pulse Builder implements a Voltammetric scan with the usual 

parameters: E_start, E_end, E_step. This will generate a staircase scan, with a pulse 

pattern superimposed on each staircase level:  

 

 

 

 

 

 

 

 

 

 

 

 

 

Selecting “PulseDefinition” opens a pop-up, in which the pulse pattern can be defined, 

for example the pattern above can be achieved with these settings: 
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Levels: the number of Levels (pulses) can be defined (min. 1, max. 4).  

Delay Time: wait-time after each staircase level application, before the first pulse is 

applied (min. 5ms, max. 5000ms).  

E/Volt:  pulse height/amplitude  (V) 

Period/ms:   pulse period (ms) 

Add to Result: result multiplication-operator   

 

Up to 4 pulse levels can be defined, each between 1ms and 200ms. The total duration of 

the 4 combined pulses must be below 600ms (Delay Time not included). 

 

At the end of the “Delay Time”, and at the end of each level, the current is measured. 

These recorded values can be used to calculate the single datapoint that is displayed and 

stored. The user can define how that datapoint will be calculated, using the “Add to 

Result” field in the definition screen. Each level measurement can be 

added/subtracted/ignored/etc. in the end-result with multiplication-operators ” +1/-

1/0/0.5/-0.5”. In the example below, a DPV scan is compiled with 50mV amplitude and 

10ms pulse time: 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The “+1” operator at Level[1] will add the measured current at Level[1], and the “-1” 

operator at Delay Time will subtract the current measured during Delay Time, so the 

difference of currents from before and at the end of the pulse will be recorded.   

 

The sampling acquisition period is set automatically equally for all levels to 25% of the 

shortest Level Period, maximized to 1 mains line cycle period (50Hz/60Hz option). These 

acquisition periods are always located at the end of the corresponding Level. 

 

Note that the ScanRate is implicitly defined by the “E step” parameters and the sum of 

Delay Time and Pulse Periods. In the DPV example above, the total period is 100ms, so 

this scan would produce 10 datapoints/second. Suppose Estep was 10mV, the scanrate 

would be 100mV/sec.  

 

 

3. Automatic data storage and file structure 

 

In IviumSoft versions 2.1XX an important change has been introduced in the way data is 

stored and retrieved in the software. This has been done to improve on ease and 

accessibility. The most important changes are: 

 

A) All measured data is now automatically stored on disk upon completion of the 

experiment. As a result: 

 

¶ The AutoSave method parameter is no longer available. When loading older 

methodfiles, the “Automatic save” settings are ignored.  
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¶ In BatchMode, the automatic data saving is also implemented, which means 

that all parameters regarding data saving are also removed here. When 

running older batch files, the target data file names and folders are ignored. 

 

B) The new automatic data saving mechanism creates “regular” idf-files that are 

readable in the usual manner.  

 

C) The file names and folder locations for auto-saving are automatically created in a 

structured manner. In this way saved files are easy to locate and retrieve, and 

data can be stored under a project name. 

 

In \:IviumStat a file folder named "data" is automatically created. In this "data" 

folder libraries are created, which in turn can contain multiple projects. 

 

\:IviumStat\data 

    Library 1 

    Library 2 Project 1 

      Project 2 

       | 

      Project n 

    Library n 

 

 

D) Manual saving of data files and data sets remains possible in the usual way. 

 

E) Data files are stored under an automatically generated file name that is 

constructed from: 

 - Scan id; (=automatically incremented scan number) 

 - Date stamp; (mm,dd) 

 - Technique used; (for example LSV for Linear Scan Voltammetry) 

 - First 8 letters (signs) of the Title of the experiment 

 - Instrument serial number. 

 

 

3.1 Data file management 

 

Data will be stored to disk automatically on the following events: 

 

¶ On completion of the datascan (or all datacycles in multiscan run) 

¶ When the "timed savings" period expires before the scan finishes, default every 

600 minutes: 

Á The 1st occurrence of an expiry period, the data is saved in .idf 

format 

Á At subsequent occurrences of expiry periods, the data is saved in 

CSV format, each time overwriting the previous CSV file.  

Á After the scan finishes, the complete data is saved in .idf format, 

overwriting the 1st saved idf file.  

 

¶ When the total number of datapoints exceeds workfile size, default 400,000 

points (user definable, see paragraphs 3.3 Data handling and 22 Working with 

large data files): 

Á When scan exceeds workfile size, an .idf will be stored with present 

number of datapoints. Also a CSV file is created with half the 
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present datasize (200k), and those points are deleted from shown 

scan. 

Á At subsequent occurrences of exceeded workfile size, the 1st data-

half is saved in CSV format while deleting it from the shown data, 

each time appending to the previous CSV file. 

Á After the scan finishes, the complete data is saved in .idf format, 

overwriting the 1st saved idf file. (it uses the CSV file to recover all 

datapoints).  

 

Datafiles will be deleted: 

 

¶ From the “tempfile” folder automatically, after the (user defined) expiry period, 

default 90 days (user definable, see 3.3 Data handling). 

¶ Manually by the user, by selecting “delete permanently” 

 

 

3.2 Data file history list 

 

¶ Below the Results panel a new Listview panel is visible. This list of files will be 

visible in the order that these were recorded or loaded, the most recent file at the 

top. These files can be used for quickly switching to earlier results and back. The 

Listview panel keeps track of all data stored in the current session; when 

(re)starting IviumSoft the most recent 25 stored/called datafiles are listed 

(default). Files listed in RED are stored in the 'tempfiles' project and subject to 

automatic deletion after a user defined time (see 3.3: Delete temporary files).  

 

 
 

Multiple scans/files can be selected simultaneously by holding the [Shift] or [Ctrl] 

button and clicking on the desired scans/files 

 

¶ The history list displays the most relevant scan (method) properties: 

Scan id: automatically generated scan number. 

Nscans: number of scans in the datafile/dataset; datasets are highlighted in 

yellow. 

Title: scan title (= method parameter). 

Technique: electrochemical technique used to acquire the data in the file. 

SN: serial number of the Ivium instrument used to acquire the data. 

Chan: Ivium-n-Stat channel number (=1 for a single channel instrument). 

Cycle: cycle number for multi cycled experiments (=1 for single cycle). 

Status: results status, 100% = fully completed 

File: file path and name; the file name is automatically generated from 

scan id, date (mm,dd), technique and first 8 letters of the title. 

 

¶ A file from the history list can be loaded by double clicking it. Right-clicking it will 

allow other options: 

 

Load Scans: will load the selected scan, replacing the previous. 

Add Scans: will load the selected scan while retaining the previous. 
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Copy File: will place the file on clipboard for copying; paste in MS Explorer will 

create a copy of this file in the active folder, paste in an email 

program will include the datafile as attachment, etc. 

Move to activeproject: 

 will move the data file from its present location to the active project 

location. This could be used to promote temporary files to a 

permanent status. 

Move to tempfiles: 

 will move the data file from its present location to the temporary 

data folder. This file will be deleted automatically, after the defined 

expiry period (see data handling options). 

 

Delete permanently:  

 will delete the datafile immediately and remove it from the 

historylist.      

 

¶ Older style datafiles (recorded with earlier IviumSoft versions) will appear in this 

list when loaded (data unavailable in these datafiles will be displayed arbitrarily). 
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3.3 Data handling options 

 

The data handling options can be accessed from the main menu bar under 

Options>Options>Datahandling Options:  

 

 

 

 

 

 

 

This will open a pop-up that allows setting how  

measurement data is stored: 

 

Operator name: the users name may be entered; 

this will be stored in the datafile 

Library: name of a group of projects. A 

library is a higher folder level, 

that can be used to group 

projects together. The active 

library is used to store new 

datafiles; a new one can be 

created, or an existing one can 

be called from the drop down 

menu. 

Project: Folder that contains the datafiles. 

the active Project folder is used 

to store new datafiles; a new 

Project can be created, or an 

existing one can be called from 

the drop down menu. [see also 

3.4]. 

Timed saving every: 

 number of minutes before next 

automatic data saving will occur. 

All data will be saved 

automatically upon completion of 

the experiment. However, if a 

long term experiment is carried 

out, the data is also 

automatically saved at the end of 

every period that is specified 

here. 

Maximum workfile size: 

 maximum workfile size before 

automatic datastreaming takes 

place; default is 400,000 points (min. 2,000; max. 2,000,000, see 

paragraphs 3.1 and and 22. Working with large data files). 

Maximum in historylist: 

 number of datafiles listed in history list (for experiments ultimately 

resulting in more scans/files than specified here, all scans/files will be 

shown in the history list upon completion). 

Always createdata CSV file: 

 when checked, every time a data file (.idf) is saved, a copy of the 

primary data is saved as an ASCII file in the same location (this CSV file 

will have the same name as the .idf file). The CSV file only contains the 

raw data, with comma separated columns (the same as when "copy to 

clipboard" is selected from the "Result data" tab). Usually the .csv 

extension is registered by MS Excel, and double clicking will open it.  
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Save multiscan runs in dataset files: 

 Multiscan experiments can produce multiple cycles after a single click on 

"Start". These cycles can be saved in the usual manner with each cycle 

in a separate .idf file. However, when this "dataset" option is activated, 

such scans are stored together in a single .ids file. 

Maximum Nr of visible cycles: 

 The number specified here is the maximum number of cyles (latest 

cycles) that will be shown in the graph during a multi-cycle experiment. 

When running a multi-cylce experiment with a large number of cycles 

limiting this number will prevent the graph from becoming 

undecipherable. 

Maximum Nr of stored cycles: 

 The number specified here is the maximum number of cyles (latest 

cycles) that will be stored in the datafile during a multi-cycle 

experiment. When running a multi-cylce experiment with a large 

number of cycles limiting this number will prevent the data file from 

becoming too large. 

Copy data to external folder: 

 This allows to store copies of the datafiles to other locations, such as 

user defined folders, network drives, dropbox, etc. The data is stored 

simultaneous with the automatic storage to the project location.  

 

¶ Save datacopy: when checked, a copy of the data is stored to the user 

defined folder. If the destination location is not available, or invalid, the 

command is ignored without an error message. 

 

¶ Redefine filename: normally the filename of the external copy will be 

the same as for the automatic generated filename of the project 

version. However this behavior can be overridden with this checkbox. If 

checked, the user defined filename is used instead. If the user defined 

filename already exists, an underscore and (incremented) number is 

added to the filename. 

 

Delete temporaryfiles: 

 The folder "Tempfiles" is normaly used to store files with a temporary 

status, such as exploratory measurements. These will automatically be 

deleted after the user defined time, default 90 days.  Also, there is an 

option to "Never" delete automatically. 

 

 

3.4 Project definition/selection 

 

The Project where newly generated datafiles are stored can also be accessed and/or 

changed directly from the top menu bar: 

 

 

 

 

 

 

A new Project name can be entered directly, or an existing one can be selected from the 

drop down menu. The project name entered here is automatically copied to the 

Datahandling options. 

 

For exploratory work, if measurements do not need to be saved for permanent use, you 

can, for example, create/select a Draft (project) folder, which can be (manually) deleted 

on a regular basis. 
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3.5 Saving Data sets and methods in Projects 

 

Data Sets 

By default data files are saved as .idf. When multiple scans are created in a single 

experiment, such as for example when running an number of CV cycles, it is possible to 

store these as a dataset in the current project. This can be done from the main menu 

bar: File>Save dataset in project. 

 

 
 

In the Data Explorer window data sets are highlighted in yellow. 

 

Methods 

A method (technique) with all parameters can be saved as method file (.imf) in a 

Project. This can be done from the main menu bar: File>Save method in project. In the 

Data Explorer window data sets are highlighted in green. 

 

 

3.6 Data exploring options 

 

From the top menu bar, a Data explorer can be opened: File>Data explorer.  

 

 
 

This will open a Data Explorer window (note that depending on the amount of data, this 

may take some seconds): 
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The Data Explorer window shows: 

¶ the Library and Project tree to the left 

¶ the list of data files in the selected Project to the right 

¶ when a data file is selected, it will show a preview of the graph and method 

parameters below. 

 

The list of data files can show different colors: 

¶ Regular black on white: data file  

¶ Highlighted in yellow: data set 

¶ Highlighted in green: method file 

 

 

From the Data Explorer window: 

¶ Copy: will put the selected file(s) on the clipboard for copying (to, for example,  a 

folder or e-mail). 

¶ Delete: will delete the selected file(s) to the trash folder. 

¶ Load File: will load the data file to the primary window. 

¶ Add File: will add the data to the data already present in the primary window. 

¶ Cancel: will close the Data Explorer window. 
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4. Corrosion techniques 

 

There is a large worldwide market for electrochemical instruments to study corrosion. 

Corrosion Scientists can be found in industrial and academic laboratories.  After many 

years of development, electrochemistry is now considered to be a standard tool in 

corrosion laboratories. A group of corrosion techniques has been added: 

 

 
 

4.1 Eoc monitor 

 

The Eoc monitor technique will allow the monitoring of the open circuit potential versus 

time. 

 

Method parameters: 

 

Title:  scan title 

Eoc interval:  interval time between data points, min. 0.1s; max. 60s. 

Run time:  duration, min. 2s. 

Stop when dE/dt<: experiment is automatically terminated when this criterion is met, 

min. 0 mV/s; max. 65 mV/s. 

 

 

4.2 Polarization Resistance 

 

The Polarization Resistance technique allows a linear potential controlled scan from E 

start to E end. The results can be displayed as I/E, E/I, Log(I)/E, E/log(I). The most 

common presentation is E (Y-axis) vs. I (X-axis) and is used to measure the corrosion 

rate. 

 

Method parameters: 

 

Title:  scan title 

vs Eoc:  when activated, the E oc will be monitored before the scan is 

started and the E parameters can be entered to be relative to E oc. 

E start:  start potential 

E end:   end potential 

E step:  potential step increment  

Scanrate:  rate of the potential scan 

 

 

4.3 Tafel Plot 

 

The Tafel Plot technique will record a linear potential controlled scan from E start to E 

end. The results can be displayed as I/E, E/I, Log(I)/E, E/log(I). The most common 
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presentation is E (X-axis) vs. log I (Y-axis) and is used to measure the corrosion rate. 

The corrosion parameters can be calculated from the Corrosion rate analysis (above the 

graph: Analysis>Corrosion rate) 

 

Method parameters: 

 

Title:  scan title 

vs Eoc:  when activated, the E oc will be monitored before the scan is 

started and the E parameters can be entered to be relative to E oc. 

E start:  start potential 

E end:   end potential 

E step:  potential step increment  

Scanrate:  rate of the potential scan 

 

 

4.4 Potentiodynamic 

 

The Potentiodynamic technique will record a linear potential controlled scan from E start 

to E end. The results can be displayed as I/E, E/I, Log(I)/E, E/log(I). The most common 

presentation is E (Y-axis) vs. log I (X-axis) and is used to qualitatively evaluate the 

corrosion characteristics of the sample. 

 

Method parameters: 

 

Title:  scan title 

vs Eoc:  when activated, the E oc will be monitored before the scan is 

started and the E parameters can be entered to be relative to E oc. 

E start:  start potential 

E end:   end potential 

E step:  potential step increment  

Scanrate:  rate of the potential scan 

 

 

4.5 Cyclic Polarization 

 

The Cyclic Polarization technique will record a cyclic potential controlled scan from E start 

to Vertex 1, and back to E start. The results can be displayed as I/E, E/I, Log(I)/E, 

E/log(I). The most common presentation is E (Y-axis) vs. log I (X-axis) and is used to 

evaluate the tendency of the sample to undergo localized corrosion.  Pitting and crevice 

corrosion are the most common examples of localized corrosion. 

 

Method parameters: 

 

Title:  scan title 

vs Eoc:  when activated, the E oc will be monitored before the scan is 

started and the E parameters can be entered to be relative to E oc. 

E start:  start potential 

Vertex 1:  Vertex potential (point at which the scan is reversed) 

I Vertex:  Vertex current, maximum current allowed before scan direction is 

reversed.  

E step:  potential step increment  

Scanrate:  rate of the potential scan 

 

 

4.6 Galvanic Corrosion 

 

The Galvanic Corrosion technique will record the current versus time when two different 

metals are immersed in an electrolyte. The results can be displayed as E/time and 
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I/time. In the Galvanic Corrosion experiment, the instrument acts as a Zero Resistance 

Ammeter. 

 

The galvanic corrosion technique is implemented for low currents, smaller than and up to 

ca. 1mA. If the currents exceed a few mA, this electrode connection cannot be used 

anymore and a transient technique needs to be used, like Mixed Mode1. 

 

Electrode connection for Galvanic Corrosion2: 

 

¶ RE to reference electrode  

¶ WE+S to working electrode 1  

¶ Gnd to working electrode 2 

 

Method parameters: 

 

Title:  scan title 

Interval time:  interval time between data points, min. 0.1s; max. 60s. 

Run time:  duration, min. 2s. 

 

 

4.7 Corrosion Rate Monitor 

 

The Corrosion Rate Monitor technique will start with recording the Eoc, after this a Linear 

(potential controlled) Polarization Resistance measurement will carried out. This is 

repeated for the duration of the experiment and the Rp and corrosion rate are displayed 

vs. time. This experiment is commonly used to test the performance of corrosion 

inhibitors. 

  

Method parameters: 

 

Title:  scan title 

Duration:  experiment duration, min. 2 minutes. 

Repeat interval:  duration of the E oc recording 

E start:  start potential of the LPR measurement 

E end:  end potential of the LPR measurement 

E step:  potential step increment of the LPR measurement 

Scanrate:  rate of the potential scan of the LPR measurement 

 

 

5. Enhanced AutoCR 

 

¶ Pre ranging 

It is now possible to let the automatic current ranging start before the measurement 

so that the instrument will automatically look for the appropriate Current Range. This 

will ensure the measurement starts with an appropriate setting. The pre-ranging can 

be switched on/off with the checkbox in the AutoCR subparameter group. 

 

 
 

                                           
1 Note that when using the transient technique, the electrode connection needs to be adjusted to 

the 'default' configuration. In Mixed Mode apply 0V to measure galavanic corrosion. 

 
2 Galvanic Corrosion is implemented similar to ElectroChemical Noise, the same electrode 
connection applies. See also p. 22/56 of the Manual.  
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¶ Pretreatment and Equilibration 

The Automatic Current Ranging option is now also activate for the Pretreatment and 

Equilibration stages. This  will enhance the dynamic measurement range during the 

pre-measurement stages. 

 

 

6. Continue Button to proceed to next measurement stage 

 

Prior to a (method) measurement, there are several pre-measurement stages: 

 

1. Purging 

2. Pretreatment 

3. OCP measurement 

4. Equilibration 

 

The duration of these stages is predefined. However now it is possible to manually abort 

such stages during its execution, by pressing the "Continue" button. This will stop the 

currently running pre-measurement stage, and proceed to the next. If it was the last 

scheduled stage, the measurement will start immediately. In case of the OCP 

measurement stage, it will accept the last measured value as the actual OCP, and 

proceed. 

 

The "Continue" button only appears next to the "Abort" button at the start of a method 

and during the pre-measurement stages, at the bottom of the method Tab: 

 

 
 

 

7. BatchMode with embedded Methods 

 

A new function was added to the BatchMode: "DefineMethod": 

 

a. "DefineMethod" will allow you to define a Method procedure inside the BatchScript. 

You can select  the Technique and edit measurement parameters directly. 

b. The "DefineMethod" variables are fully embedded in the BatchFile. You do not need 

to rely on external method files. When you change the file location, or move to 

another pc workstation, you only need to transport the ".ibf" file. 

c. The old "LoadMethod" function is retained, for compatibility reasons. But it is 

recommended not use this anymore. 

d. When saving BatchFiles, it is suggested to store these in the active Project folder. 

When you select LoadBatch/SaveBatch, the filename selection dialog will start in the 

active project folder. 
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When DefineMethod is selected, the measurement can be configured in the table below 

the BatchScript. Above the property grid, 4 buttons appear: 

 

• Load: will load (import) the parameters from an existing methodfile on disk. These 

are loaded at the moment you press this button, and embedded in the active 

BatchFile. If that original sourcefile would be removed/changed afterwards, it 

would not affect the embedded Method definitions. 

• Save: will save (export) the methodparameters to a method "*.imf" diskfile. 

• Get Active: will copy  the parameters from the active Method, as it is displayed on 

the main Method tabsheet. 

• Set Active: will export the DefineMethod parameters to the active Method, and will 

be displayed on the main Method tabsheet, replacing the previous active Method. 

 

It is important to note, that while a BatchScript is being edited, the DefineMethod 

parameters can be different from the active Method settings on the MethodSheet. Also 

note that a BatchScript may contain several different Method definitions. However, when 

a Batch is run, and a DefineMethod line is executed, the active Method setting will be set 

according to the embedded Method definition on the active line. 

Batchfiles (.ibf) can be saved as usual. These must be saved by the user, these are not 

saved automatically. 
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8. Mixed Mode enhancement 

 

For specific applpications the Mixed Mode technique has been enhanced with additional 

method parameters: 

 

Main method parameters: 

 

Continuous AC: When checked this will maintain the AC amplitude throughout the 

Level continuously (otherwise it will be switched off during DC 

acquisition). 

 

AC mean current: This will measure the mean AC current, instead of the DC current, 

and plot this in the main dataplot (black line, left axis). The mean 

current value is defined by averaging the quadratic current over a 

finite number of ac cycles, after subtraction of the dc current. 

Please note that the thresholds for currents, are now applicable to 

the AC Mean current. 

 

ThresholdHoldoff: Time that threshold checking is inactive at each level. This 

parameter is to be used when, after a levelchange, it is undesirable 

that threshold switching happens too fast. It puts a minimum 

duration to the level. It is useful when systems need a stabilization 

time.  

 Note 1: the time is always counted from the start of the active 

level, so it is "reset" at each level change.   

 Note 2: the TresholdHoldoff time should not exceed the level 

duration. 

 

Level parameters (stages pop-up window): 

 

Define ac: When checked this will overrule the main method parameters 

Frequency and Amplitude.  This allows you to select a dedicated 

frequency and amplitude for each separate level. 

 

 

9. Mixed mode: Exit scan at threshold 

 

By default, the thresholds in the Mixed mode level panel will only act within the level. If 

a threshold is exceeded, this Level is aborted and the scan continues to the next Level. 

Now, an extra option is available: "ExitScanOnThres". If checked and when a threshold is 

triggered, it will abort the complete scan. 

 

 

10. Mixed Mode: Repeating Sequences and conditional branching 

 

Groups of consecutive Levels can be defined as a sequence and repeated multiple times 

(Loops). Also, the sequence can be made conditional to definable thresholds.  

A sequence can be defined, by checking the "SequenceStart" and "SequenceEnd" 

parameters, at the desired Levels. All the enclosed Levels will be part of the sequence-

block. The SequenceStart parameter has a subparameter "SeqRepeatCount" to define 

how many times the sequence-block will be executed.   

 

 
 

The blocks can be recognized in the Level view, by the opening and closing square 

brackets "[ ]" in the properties line, with the repeatcount before the opening bracket.  
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The SequenceEnd parameter has a subparameter "SeqExitOnThres" checkbox to leave 

the sequence-block when a Threshold value was exceeded. In this way, repeating 

sequences can be defined that are aborted by a boundary condition. For example: 

cycling charge/discharge of a battery, until the potential exceeds a critical value.  

 

 
 

Sequences can be started and ended at each level. The SeqRepeatCount can be defined 

from 1-65535. Sequence-blocks can enclose other sequence-blocks (loop nesting), up to 

8 levels deep. 

 

 

11. Pretreatment before every frequency 

 

For the potentiostatic Impedance technique "Constant E", the advanced method 

parameter “Pretreat each freq” is added. By checking this option, the pretreatment 

sequence is repeated before each new applied frequency. 

 

During each pretreatment, the ac signal is removed, and the dc current is measured 

once every second. The (subsequent) pretreatment measurements are recorded and 

added to the Pretreatment data. 

 

 

12. Add timestamp to exported ASCII data 

 

When using "Export Data as ASCII", it is possible to add the time and date of the 

measurement. This feature can be activated in the menu Tools>Datahandling options, on 

the "Content Tabsheet", by checking "Add timestamp". 

 

When activated, the time and date will be written on the first line of the Exported ASCII 

file. The time corresponds with the Starting Time of the scan. 

 

 

13. Monitoring Energy and Charge parameters 

 

New features have been added to the Mixed Mode technique, that can be used for 

example for battery testing. During Mixed Mode experiments, the Charge and Energy 

state (for example of a battery) can be monitored against Time or Cycle number. To 

access these features click on the Q button to the left of the Result Graph. The second 

graph that becomes visible (as before) has now added to it a new bar with labeled 

buttons (only in Mixed Mode). To select the display parameter click on the relevant 

button: 

¶ Q/t:  Charge vs. time 

¶ C%/t:  (Capacity/Nominal Capacity) * 100% vs. time 

¶ P/t:  Power vs. time  

¶ U/t:  Energy (U) vs. time (integrated P/t plot) 

¶ Q%/cls: (Q_discharge/Q_charge) * 100% vs. Cycle nr. 

¶ U%/cls: (U_discharge/U_charge) * 100% vs. Cycle nr. 

¶ C%/cls: (Capacity_discharge/Nominal Capacity) * 100% vs Cycle nr. 

¶ Uc/cls:  U_charge vs Cycle nr. 
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The Nominal (battery)  Capacity is a user defined parameter in the method parameter  

Data Options/Electrode, in Coulombs. Note that 1mAh=3.6C. The numerical data vs. 

time, can be viewed/exported from the Result Data Tabsheet, using the Extended Data 

option. 

For plots against Cycle nr., it is necessary to have each cycle loaded as individual scan. 

Check "Cycle separate" in the method parameters. By default the plots are only updated 

after a button on the bar is pressed. Optionally, the plots can be updated automatically 

in rea ltime while a scan is in progress, by checking "Automatic charge calc." in the 

menu "Options/Settings". 
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14. Mixed Mode at Controlled Power 

 

In the Mixed Mode technique an extra control mode has been added. Next to controlled 

E/I/OpenCell/Z in Mixed Mode, also the applied Power can be controlled: P Control. The 

Power is defined in Watt, and is calculated from the product of the (S-RE)-voltage and 

the WE-Current.  

 

 
 

A positive applied power means that the instrument will apply a positive current, and a 

negative applied power will generate negative current. Note that the potential can be 

positive or negative in either of the latter cases; the sign of the "real power by the cell" 

depends on the object. For example for an active object, such as a battery, a positive 

applied power means that the battery is being charged by the Energy of the instrument, 

while for a negative applied power Energy will be drained from the battery, but the 

battery voltage in both these cases is "positive".  

 

In "P control" mode, the instrument uses a fixed Current Range. AutoCR cannot be used. 

For the best performance, it is advisable to select the best initial Current Range and 

Potential Range. 

 

 

15. Remote driver .dll update and version control 

 

The IVIUM_remdriver.dll has been updated to version 3. 

The version can be read by the calling program with the 

"IV_version" function that can be imported from the .dll. It 

returns an 32bit integer with the version number.  

The required IVIUM_remdriver version for IviumSoft can be 

verified in the top menu option "About". Clicking on this will 

open a pop-up window. At the bottom left the IviumSoft 

release version is given, behind it between brackets [..] the 

IVIUM_remdriver.dll version it corresponds with. 
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16. Labeling and Bookmarking Datafiles 

 

Datafiles can be labeled with a description and/or bookmarked for convenient recognition 

and later retrieval. Directly above the file history list, a field is available where the 

"Description" of the selected scan can be entered. The new description can be stored in 

the datafile by pressing the Apply button. 

 

 
 

This description will appear in the 3rd column of the filelist.  The description text can be 

of unlimited length. 

 

Datafiles of special importance can be bookmarked, by checking the Bookmark box and 

subsequently clicking "Apply" (unchecking the button and clicking "Apply" will remove 

the Bookmark. Bookmarked files can be recognized by the underlining in the file history 

list. Directly to the left of the file history list, there are 2 buttons:  

 

[Files]  shows the usual historylist of datafiles 

[Bmrks] brings up the list of bookmarked files. 
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Bookmarks can also be set/removed by right-clicking on a datafile in the Historylist or 

Bookmarklist, and selecting the appropriate item form the popup menu. 

In the Data Explorer, bookmarks can also be created. A list of all bookmarks files can be 

shown by selecting the "Bookmarks" branch in the root of the Projects tree (on top). 

 

    

 

17.  ECN direct transient analysis 

 

In addition to the possibility to analyze  ElectroChemical Noise (ECN) data in the 

frequency domain (Fourier, MEMS, etc.), now the time domain transients can be 

evaluated directly. 

On the "Time domain analysis" tabsheet of the Electrochemical Noise Analysis tool, both 

the E and I data can be analyzed, in segments over time: the full length of the ECN E or 

I data is divided into segments of user defined duration, to which the selected analysis is 

applied. The segment-results are plotted vs. time.  

 

Several analysis are available: 

 

¶ Inoise Std.dev: standard deviation of the current signal 

¶ Enoise Std.dev: standard deviation of the potential signal 

¶ Rp:   Enoise Std.dev / Inoise Std.dev 

¶ Pitting index:  Inoise Std.dev / mean current 

¶ E transients:  number of E transients* in each segment.  

¶ I transients:  number of I transients* in each segment. 

*A transient (or peak) is counted when its absolute difference from the "average 

segment value" exceeds the defined threshold. Note that consecutive points that 

exceed the threshold do not increase the transient (or peak)-count. These are 

assumed to belong to the same transient. 
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The selected time analysis is performed by clicking the "calculate" button. The results 

are shown in the graph, which can be copied by right-clicking on the plot and selecting 

"Copy". The numerical results can be copied with the "Copy data" button, and can be 

pasted into other applications (Excel, etc.) in the usual manner. 

 

 

18.  Prevent IviumSoft from closing while measurement in progress 

 

If the IviumSoft application is closed, active/running measurements are aborted and the 

data is lost. When the user attempts to close the application while a measurement is in 

progress, a message will popup: 

 

 
 

Responding with "OK" will close IviumSoft and the data is lost. Selecting "Cancel" will 

ignore the attempt to close Iviumsoft and continue the measurement. Note that the 

popup will wait for a response while the measurement continues. A response is needed 

before IviumSoft can accept new commands or settings. 
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19.  New help file 

 

IviumSoft is equipped with a 'help' function that is content sensitive: this means that 

placing your cursor or making a selection and pressing [F1] will automatically open the 

help file on the subject that is selected. 

 

Starting at IviumSoft version 2.301 the help file is based on and compiled in .html. This 

means that if you have an existing IviumSoft installation the old help file does not work 

anymore and the new .html help file needs to be installed (instructions, see below). 

 

The new .html help is expanded to include the complete manual. Next to the content 

sensitive help, of course the help file can also be opened from the top menu bar. In this 

case the complete contents of the help/manual are displayed by subject in logical order. 

The help/manual can be searched for example by subject or keyword. 

 

Future releases of IviumSoft, when relevant, will also include a new help file. New 

features of the new IviumSoft release are included in that new help file. 

 

Installing the new help file 

 

New installation: The newest help file will be automatically installed when first  

installing IviumSoft from the installation CD on a PC.  

 

IviumSoft update: When IviumSoft is updated from our webpage at 

www.ivium.com/support, a new helpfile (IviumSoft.chm) is included 

in the zipfile and should be copied together with the IviumSoft.exe 

to your IviumStat file directory. 

 

 

20.  Hiding noncompliant data in ResultGraph 

 

Previously all loaded and/or generated data would be visible in the ResultGraph, i.e. 

when an LSV was executed after an impedance (EIS) experiment without deleting the 

EIS data, the LSV data would be plotted in the EIS graph. This would cause the 

data/graph to look erratic. 

Now, only data will be displayed that is compliant with the active plot. So in the previous 

example, the EIS data would be hidden from view after the LSV started. Note that the 

EIS data is still there. If thereafter another EIS experiment would be run, the older EIS 

data would become visible again (and the LSV data will become hidden). 

 

The display mode always follows the active scan. Previous recorded/loaded scans will 

only be visible when these are compliant with the current display mode. Note that this 

will make it now possible to meaningfully combine results from different techniques in 1 

dataset.  

 

When multiple scans are loaded, containing data recorded with different techniques, the 

hidden ones can be viewed by mouseclick, while keeping CTRL pressed. This will make 

the clicked scan active, thus redefining the plot "mode".  
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21.  ChronoSequencing in BatchMode 

 

In BatchMode, it is possible to display the time 

scale of the ChronoTechnique methods relative 

to the starting time of the Batch. When multiple 

techniques are executed in sequence, their time 

variable accumulates. This mode is actived by 

checking the "ChronoSequencing" checkmark, on 

the Batch tabsheet.   

 

Note that if the "cleargraph" option is not used 

in batchmode, one can view all the Chrono 

results in one plot, in a chronological manner. 

 

 

 

22.  Realtime Impedance 

 

The 'Mixed Mode' technique allows the recording of Impedance data simultaneous with 

DC results, in real time. The minimum interval time to allow real time impedance 

measurement has been greatly reduced from 0.2 sec to 0.002 sec. But note that at 

interval times shorter than 0.2sec, the AC signal is always continuously applied 

(regardless of Continuous AC option). At interval times longer than 0.2 sec the AC signal 

is only applied at the last portion of the interval. 

 

To make use of real time impedance the the condition must be observed that: 

the Signal Frequency must be higher than (2/interval time).  

 

 

23.  ECN: Signal averaging 

 

Normally the signals for each time interval are recorded at the last portion of that 

interval: i.e. the signals are sampled at high speed and averaged during a sufficiently 

narrow period, that is automatically chosen by the instrument. The option has been 

added (in the ECN technique only) to allow the user to override this and redefine the 

period by using the "Signal averaging" parameter: 

 

 
 

By checking the "Full interval" option, the data is measured and averaged during the 

whole interval period (note the similarity with the current integration techniques). 

If the "Full interval" option is left unchecked, the user can define the "Averaging time" to 

any other value between 0.0003 and 10 seconds. Normally the Averaging time would be 

a fraction of the interval time, but it is also possible to use larger time periods. In that 

case, the averaging also uses the previous datapoints, and in fact will become a digital 

lowpass filter.     
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24.  ECN analysis: digital low pass filtering 

 

In ECN analysis, an option for digital lowpass filtering has been added: 

 

  
 

In the frequency domain a filter function can be applied by checking "Apply". The 

frequency and the order can be set by the user. The frequency will correspond with the 

cut-off frequency: at which half the signal magnitude is attenuated. The order gives the 

"slope" of the filter: 1st order = 20dB/decade, 2nd order=40dB/decade, etc. 

 

 

25.  Power optimization for active Cells.  

 

A new mode has been introduced in the "P-control" of the Mixed Mode technique. This 

"P-maximum" -setting facilitates the further investigation and operation of active cells, 

such as Batteries, Fuel Cells, SolarCells, and other power generating devices. 

 

The power that a device (Cell) generates is dependent on its Potential/Current settings. 

Often there is a certain E/I setpoint that yields maximum Power.  That point is not 

known in advance and/or is constantly changing, i.e. consider a Solar Cell for which the 

incoming light is variable. When the "P maximum" option is checked, IviumSoft will 

automatically select the E/I settings that yield maximum power. The  Potential/Current 

settings are continuously adjusted, so the device is always operated at it maximum 

power output. 

 

Note 1: The P-maximum is software controlled, based on real-time measured values. 

Note 2: The P-maximum point is re-calculated at each 'interval time', so the shorter 

the interval, the faster the 'control loop'. 
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To operate a cell at maximum power, in Mixed mode technique, Levels, select P control. 

In the Properties check "P maximum".  

This mode can be used like any other Mixed Mode regime, and can be sequenced at will. 

 

 

26.  Importing Protocol Templates in Mixed Mode (PITT, GITT)  

 

To facilitate the compiling of complex sets of method parameters, it is possible to add 

standard protocols. At this time, there are 2 protocols available for Battery testing: GITT 

and PITT. Over time, more will be added. 

 

To add a protocol to a Mixed Mode sequence, select the Mixed Mode technique. From the 

method parameters, open the Levels window. In the menu bar at the top of this window, 

click on 'Add protocol'. This will open an additional pop-up window for selecting and 

changing a, predefined, protocol. The protocol parameters can be edited before adding 

the protocol to the Mixed Mode. But, after adding the protocol, the lines can also be 

edited; they appear as "normal" lines. In this way the protocols can be used as 

templates, that are flexible and can be adjusted to any specific requirements. 
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27.  IviFit - IviumSoft Equivalent Circuit Fitting 

 

The  Equivalent Circuit fitting tool, that comes included with IviumSoft, has been greatly 

enhanced. 

 

 

27.1 Increased visual grid 

 

The visual grid has been increased from 5x5 to 8x8 component positions (25Ą64). This 

allows for easier building of complex circuits, and it allows even more complex circuits. 

 

 
 

 

27.2 Improved modelling algorithms 

 

The modeling has been optimized in several ways:  

 

¶ The fitting is mathematically more robust, avoiding numerical error messages.  

¶ A higher success rate is obtained due to better coping with “local minima”.  

¶ Better algorithms are applied to deal with difficult components, such as CPE (Q). 
 

 

27.3 Automatic generation of startvalues 

 

The modeling tool is now capable of generating its own starting values. This is 

convenient for the user, and it obtains better endresults. Therefore by default the 

starting values are automatically generated. Optionally, the user can still apply their own 

starting values by checking "user defined startvalues". 
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27.4 Automatic circuit suggestion 

 

When the equivalent circuit is not known, the Ivium Software can suggest a circuit that 

would fit the data the best. This is done by internally evaluating several standard 

circuits, and comparing fit quality. At this time only combinations of R,L and C are 

included. 

 

 

27.5 User definable fit boundaries 

 

The user can set boundaries for the fit-able parameters. In the circuit evaluator window 

slelect Options/Fitting Options; here the default values for the parameter types, and 

their allowable limits, can be set. These will be applied as starting values for newly 

created circuit parameters. The boundaries can also be individually edited after circuit 

creation in the actual parameter grid. 

 

 
 

 

27.6 Graphic selection of fitting range 

 

The range of data points to be included in (or left out of) the fit can be selected 

graphically: simply mouse-click on the outer data points to be included in the fit range. 

The fit range is shown in highlight. Only the included (high lighted) datapoints will be 

used in the numerical modeling and simulation. 

 

Graphic selection of the fitting range is available in the plots: Bode, Nyquist, RsCs, Y1Y2. 

 

 

27.7 Kramers Kronig test 

 

Data can be validated by means of the Kramers Kronig test. When you press the 

“KKtest” button, the KK plot will be generated. 
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27.8 Time response reconstruction from the equivalent circuit 

 

Time responses can be calculated from the equivalent circuit. Equivalent circuits are 

normally modeled from the Z vs. frequency relation. However from any equivalent 

circuit, the E&I vs. time relation can be reconstructed also. This might be useful for 

educational purposes, or verification of particular measurements in the time domain. It 

can be selected by clicking the "Time" button. There is a choice between various 

potential perturbations: SquareWave, Cosine, Impulse, Sweep, Sine, Step, Triangle.  

These perturbations can be applied either in potentiostatic mode (: apply E and measure 

I), or in galvanostatatic mode (: apply I and measure E). 

 

 
 

For SquareWave, Cosine,  Sine  and Triangle, also the frequency can be chosen. 
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It is possible to transform the axis, evaluate the time dependence of the signals: see the 

indicated example above for the linear relation of the Logarithmic decay of the impulse 

response on an RC network. 

 

 

28. Recovery of data from a .tmp file  

 

During a (long term) experiment, IviumSoft automatically saves 

data in a temporary datafile at regular intervals, to prevent loss 

of data due to an unforeseen communication loss between 

computer and potentiostat (See also paragraph 3.3). The default 

automatic saving interval is 600 minutes, but this can be 

changed by the user. The first automatic save is in a standard 

Ivium datafile (.idf) to additionally store the method parameters; 

subsequent automatic saves are done in a .tmp file that only 

contains raw data points. When each next interval passes the 

data is appended to the .tmp file (so there will always be only 

one .tmp file per experiment). At the end of the experiment the 

data is automatically saved as .idf (.ids) file and the .tmp file is 

deleted. However, when communication is lost between the 

computer and the potentiostat, and/or the IviumSoft crashes, 

the final .idf cannot be formed. But the available data is then still 

stored in the .tmp file.  

 

The data available in the .tmp file can now be easily recovered 

by importing it, using the "Import CSV" command from the "File" menu. 

 

Note that, because the .tmp file only contains raw data points and no method 

information, if you wish to recover a .tmp file from a fresh instance of IviumSoft, you 

should first load the .idf file with (containing the method information) and then import 

the CSV. 
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29.  New Batch Mode parameters  

 

29.1 EditMethod: AddindexToValue 

 

For Batch Mode, the "EditMethod" command has 

been extended with the possibility to set/modify 

method parameters automatically, where the 

parameter value is calculated from the Loop index 

counters. In this way ranges of measurements can 

be scheduled, with regular changing parameters. 

 

The  "AddIndexToValue" parameter has been added 

to the "Line properties" or the "EditMethod" 

command: 

 

When the "AddIndexToValue" parameter is checked, 

the new value of the selected parameter is 

calculated as follows:   

 

Newvalue =  

ValueText + (Loop_index * IndexMultiplier) 

 

¶ The 'IndexMultiplier' is user defined and can be 

any value; 

 

Note1: the 'IndexMultiplier' is the increment for 

the 'Parameter' with start value 'ValueText' 

Note2: that no check is executed to see if a 

valid 'Newvalue' is achieved, it is the users 

responsibility to choose the 'IndexMultiplier' value wisely). 

 

¶ The 'Loop_index'  is the actual value of the Loopcounter during the running batch.  

 

¶ The 'IndexFromLoop' parameter allows you to select which Loopcounter is to be 

used, if multiple Loops are nested. A value of 0 means that the actual  (inner) 

Loopcounter will be used, for an 'IndexFromLoop' value of 1 the Loopcounter of 1 

level higher will be used, etc. When that number is higher than the outmost Loop, 

the outmost Loopcounter will be used.  

 

In the Batch example above an LSV is created [Line1] with a Scanrate of  50mV/s. In 

Loop #1 the LSV is executed with Scanrate  = 50mV/s =0.05V/s [Line3]. Then the new 

Scanrate is recalculated [Line4] to become: 0.05+(1*0.01) = 0.06V/s = 60mV/s. Then 

Loop #2 is executed with Scanrate = 60mV/s, etc. In this example, 4 loops are executed 

with subsequent scanrates of 50mV/s, 60 mV/s, 70 mV/s, 80 mV/s. 

 

 

NOTE: The "Incremental" parameter in the "EditMethod" Line properties has the usual 

meaning. It will add the previous value to the new value. Note that if you enable both 

"AddIndexToValue" and "Incremental", it creates a complex situation which will quickly 

run over parameter limits. Therefore it is not recommended to use both options at the 

same time. 
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29.2 DirectCommand: WaitForAn1 

 

This feature allows a batch to wait for a specified 

analog voltage on the peripheral port (Analog 

Input1). The value can be specified in the "Until 

An1>" field. Also a "Timeout" value may be 

specified: after this time the Batch will continue 

regardless the state of the analog input. 

 

 

29.3 DirectCommand: ExecuteProgram 

 

In BatchMode a new command has been added 

to the 'DirectCommand' line to enable that 

external programs can be executed in a 

controlled manner. In the DirectCommand 

batchline, "ExecuteProgram" can be checked: 

  

The following sub-properties appear: 

¶ Program Name:  

Enter the filename of the program to be 

executed, using the path below 

¶ Path:  

Location of the program; If left empty, 

the executable will be assumed to be in 

the same folder as IviumSoft 

¶ Command Line: 

Optional parameters to be transferred to 

the external program 

¶ ScanAsCmdline: 

If checked, the last recorded scan 

filename will be used as command line 

¶ WaitUntilFinished: 

If checked, the batch will be paused until 

the external program is finished. 

 

 

30.  Changing corrosion rate unit: mm/yr to mpy 

 

To change the unit of the displayed/calculated corrosion rate in IviumSoft from mm/yr 

to mpy (milli-inches per year), the following steps should be taken: 

 

¶ Open IviumSoft and navigate to the Options tab at the top left hand corner. 

¶ Select  'Datahandling Options' from the drop down menu. 
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¶ The pop up box shows two tabs, select the 'Content' 

tab. 

¶ In the box 'Data display' check the field to use 

mpy instead of mm/yr and click 

'Apply'. 

¶ Close the box. 

¶ Displayed data will now be in mpy (milli inches per 

year). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

31.  Corrosion techniques: Corrosion Rate Monitor > data (2.566) 

 

31.1 View & Export OCP-data 

 

¶ Corrosion Monitoring data in the table in the Result data tab now lists an extra 

column with the Eoc values. 

 

¶ When exporting the data in this table, also the Eoc values are exported. 

  

 

31.2 View and Export LSV-data 

 

¶ The LSV data belonging to a Corrosion Monitoring experiment can now be viewed 

in the table in the Result data tab, by checking the 'CorMon LSV' checkbox in the 

Format group. 

Note: this checkbox will only work if Corrosion Rate Monitor data available. 

 

¶ The LSV data can be exported as usual.  

 

 

31.3 Eoc results data reduction 

 

¶ To minimize data file size, superfluous Eoc data is not stored. 

 

¶ Only  the following data is only stored:  

 

i. The first 5 points of each Eoc period; 

ii. All data points where Eoc is more than 0.2mV different from  the 

last stored point;  

iii. Data points after a maximum time interval of 10 minutes;  

iv. The last point of each Eoc period. 
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32.  Select metal/alloy properties from table for corrosion calculation (2.566) 

 

When entering material properties for Corrosion calculation, a library of predefined data 

can be used to obtain Density and Equivalent Weight. 

 

¶ In the Method paramter > DataOptions pop-up, select the 'Electrode' tab. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

¶ Under 'Electrode properties in the 'Material Constants' field a table can be opened 

by clicking "Select from Table" 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

¶ Mouse click on the desired material to select it, the click 'Accept and Close' to 

copy the selected data to the 'Material Constants' field in the Data options. 

 

 

33.  Voltage range extension for the True Linear Scan (vs. 2.585) 

 

The True Linear Scan generator (LinScan) is a payable option available for Ivium 

potentiostats. The voltage range for the LinScan option has been increased from ±2V to 

the full applied potential range of the potentiostat and the same resolution as the applied 

potential range. The resolution of the LinScan reflects on the E-start, E-step and Vertex 

potentials, the applied signal itself is analog.  
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34.  IR compensation ElectroAnalysis and True Linear Scan techniques (vs. 2.585) 

 

IR compensation has been implemented in an additional number of techniques: 

 

- True Linear Scan (TrueLinear LSV and CV) 

- Differential pulse 

- Square wave 

- Normal Pulse Voltammetry 

 

It is available via the method paramter "IR feedback" and compensates for ohmic drop in 

the sample, via the direct feedback method. The instrument will increase the cell 

potential by the amount that is defined by the product of current and compensation 

resistance. When using IR compensation, care should be taken because 

overcompensation will result in instabilities.  

 

 

35.  Enhancement Result Analysis (vs. 2.595) 

 

35.1 Advanced Peak search: Adjustable multiplier for charge 

 

In the Analysis>Advanced peak search, the parameter "Convert result" is added. The 

Convert result is activated by checking the box. When checked the "*factor" can be 

entered. The charge is multiplied by this factor to achieve the result. The unit of the 

result is determined by the units of the factor, and can be edited by the user. In the 

example below the unit is made to be g/cm2. The converted charge to g/cm2 value (in 

this example) is displayed in the last column of the result table. 
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35.2 Find levels: Addition of inflection point and conversion factor 

  

In the analysis technique Find levels a determination of the inflection point has been 

added: after the first found level, the inflexion point is determined; this is indicated by 

an arrow marker on the plot. The inflexion point IP is defined as the point with maximum 

1st derivative, and the value is also shown in the result table.  

 

The parameter "Convert result" is also added. The Convert result is activated by 

checking the box. When checked the "*factor" can be entered. Subsequently checking 

the "*charge" will multiply the charge by the factor (factor*charge). When the "*time" is 

checked, the time will be multiplied by the factor (factor*time). When both "*time" and 

"*charge" are checked, the charge will be multiplied by the time and the factor 

(factor*charge*time). 

 

The unit of the result is determined by the units of the factor and can be edited by the 

user. In the example below the unit entered is gram. The converted value (to gram in 

this example) is displayed in the last column of the result table.  

 

The "Convert result" is also applied on inflexion points. The levels and inflexion points in 

the table can be identified by the label in the 1st column. 

 

Note that setting the parameter "Value reference" from "absolute" to "differential" will 

effect that charge, time and converted result are all relative to the previous marker, 

rather than absolute values. 
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36.  Synchronise Start of Ivium-n-Stat channels (vs. 2.606) 

 

To facilitate the synchronised start of methods 

running at multiple channels/modules in the same 

Ivium-n-Stat frame, a selection parameter for 

channels is introduced. This parameter 

"SyncChannels" is available from the "Method" tab 

as a subparameter of the "Modules".  

 

When the box is checked it will suspend the start 

of any method on the connected channel untill the 

masterchannel starts. The masterchannel is 

always in slot 1. If this is a dModule, the A-

channel is the master. 

 

The "SynchChannels" parameter operates over 

different instances of IviumSoft, i.e. if 4 channels 

are connected in 4 instances of IviumSoft, 

pressing "Start" in each instance will make the 

channel wait for the start-trigger of the master 

channel.  

Note that when synchronisation is required, the 

"Start" button of the master channel should be 

clicked last. 

In this way even different techniques can be 

operated on different channels, but started at the 

same time. 

 

The synchronisation is executed via an internal 

electronic connection and thus not affected by PC 

or USB delays. 

If for any reason the master channel fails to 

deliver the trigger, a suspended channel can be 

released by pressing "Abort".   
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37.  ACout pulse at level [1] (vs. 2.622) 

 

In the Transient techniques ChronoAmperometry and ChronoPotentiometry a new 

method parameter is introduced: ACout at Level[1]. When checked this allows the 

application of a pulse of user defined E, from the peripheral port, during the application 

of the first Level of ChronoAmperometry and ChronoPotentiometry. The pulse range is 

+/-2V. The timing corresponds to the Level specifications. However, at HiSpeed, an 

additional delay of about 8µs should be taken into account, making the minimum 

pulsewidth ca. 18µs. 

 

 

38.  CV plot analysis enhancements (vs. 2.622) 

  

When a CV plot is available in the Result graph window it can be 

evaluated by right mouse clicking on the graph and choosing the 

option CV plots: 

 

 

 

 

 

 

 

The CV plots tool has several new features: 

 

a. Integration tool: currents can be integrated to charge over the full forward or 

reverse scan, or over a narrower user selected potential range. 

b. Q vs. E: CV plots can be displayed as charge vs. potential. When choosing to plot 

the CV in Q vs. E automatically the capacity is determined from the enclosed area 

in the CV plot according to:  Cap = ½ * (abs(Qf) + abs(Qr)) /delta_E. 

c. Cap vs E: Capacity plots can be displayed; in this case the CVs are "normalized" 

according to: Cap = current /scanrate 

 

 

39.  Coulometric plot analysis (vs. 2.622) 

 

A new analysis technique has been added to evaluate 

Coulometric plots constructed from ChronoAmperometry-

data. The new "Coulometric plot" can be accessed from 

the Analysis drop down menu above the Result graph:  
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For each potential level (max 2), the Charge is plotted vs. the Sqrt(Time). According to 

theory for diffusion limited reactions, this yields straight lines. The slope and intercept 

are calculated by linear regression on the last 80% of the datapoints in each Level. 

These results are reported in the panel to the right of the Coulometric plot window. 

Note that the reported time is relative to the start time for each Level. Each Levels starts 

at Time=0s. 

 

 
 

 

40.  Working with large datafiles (vs. 2.627) 

 

When experiments produce a large number of datapoints (>10^5), the Windows PC 

system can become unstable due to performance issues. In order to ensure reliable 

operation with such experiments, IviumSoft employs several strategies to ensure stable 

operation of IviumSoft. The main feature is to limit the maximum number of points in 

memory and visible on screen. Note that the excess data is not lost, but will be stored on 

disk. The maximum can be user defined in the "Datahandling options" (see also 

paragraph 3.3 on p.6): 

 

MWS: The Maximum Workfile Size; default 400,000 points 

 

In this new IviumSoft release, several changes have been made to ensure high 

performance and enhanced user experience. Previously if data exceeded the MWS, the 

oldest data was removed from the graphically displayed data. That removed data-section 

was streamed to disk.  

 

In the new approach, when data-length exceeds the MWS, all data is streamed to disk, 

and the visual dataset is reduced in size by removing datapoints that do not affect the 

appearance of the data in the graph. The data-reduction algorithm employs a reduction 

approach that will result in data size that just fits in the MWS. The reduction is based on 

varying thresholds. If a datapoint does not differ from its neighboring points by more 

than a defined threshold, it is removed. The magnitude of the applied threshold is 

automatically determined to keep datasize just below the MWS requirement. The user 
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can thus always keep a complete overview over the duration of the scan, while still 

capturing all its important features. 

  

At the end of the experiment, the reduced data is saved as an ".idf" file (Ivium Data 

File). That reduced data file will be about the size of the MWS. The raw data that is 

streamed continuously during the scan, is saved in a separate file with the same name 

as the .idf file, but with the ".ief" extension. Usually the reduced data contains all 

important changes and features required for further analysis. However, if the complete 

raw data is required, it can be restored: 

 

1- In the Legends panel right mouse click the desired scan: the scan properties 

popup will open.  

2- Click the button [Restore Full datasize], and all data will be shown undecimated. 

 

NOTE: for extremely large datafiles this may impair the performance of the PC. 

 

Alternatively, the .ief file can be directly imported in an external program. Contact Ivium 

for details. 

 

When the option of "Timed saving" is selected (See data handling options, paragraph 3), 

the raw datafile (.ief) is updated after every specified timing interval. This behavior 

cooperates with the "MWS savings":  the timing interval is determined from the last 

saving event. Therefore, every triggering event for MWS saving, resets the clock for the 

next "Timed saving event". When the MWS is chosen small, the Timed saving feature 

becomes obsolete. 

 

 

41.  New functions Result Data (vs. 2.645) 

 

41.1 Pretreatment/Equilibrium data in Result Data sheet 

 

In the Result Data sheet the possibility has been added to list the numerical values of 

the Pretreatment/Equilibrium in the Result Data table, and export those. 

 

 
 

 

41.2 Swap E/I Columns in Result Data 

 

At the bottom of the list of options to the left of the Result Data sheet in the "Format" 

group it is now possible for the "E" and "I" to be swapped. This can be useful when 

exporting the data to a compatible external format.  
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42.  Impedance.PotentialScan: Pretreatment before every frequency (2.645) 

 

For the impedance technique Impedance.PotentialScan, the functionality has been added 

to repeat the pretreatment sequence before each applied frequency. During the 

Pretreatment, no AC amplitude is applied. 

 

 
 

 

43. Merge Scans (2.653) 

 

In the "Edit menu"  a feature has been added that will merge all listed scans into 1 scan. 

This allows saving and analysis of all datapoints, as if these were obtained in a single 

scan. 

 

 
 

The merge operation will add all datapoints of all listed scans, and reorder those in 

sequence, according to the primary variable (E for CV/LSV, time for Transient 

techniques, etc). The ordering after a merge operation will be ascending, regardless of 

the original scan direction.  

It is assumed that all scans to be merged are of the same type. The scan produced by a 

merge operation will retain the methodparameters, that belong to the first scan.  

  

   

44. Impedance.Escan: Cp vs E (2.653) 

 

On the Escan tabsheet, the plottype "Cp vs E" has been 

added. This allows plotting of the parallel Capacity value 

against E, for fixed frequencies.  
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45.  Mott Schottky calculation (2.653) 

 

The Mott Schottky plot analysis has been extended to calculate the Flatband potential 

and ND (Donor concentration). Note that in order to calculate the correct values, it is 

required to input the T=Temperature, A= Area and ε= Relative Permittivity in the 

DataOptions (method parameter).  

 

These parameters are determined from the slope and intercept of the 1/C2 vs. E plot: 

 

 
 

with V = the potential, VFB = the FlatBand potential, ε0  = the vacuum permittivity (8.854 

× 10−12 F m−1), e = the elementary charge (1.602 × 10−19 C), kB = the Boltzmann 

constant (1.381 × 10−23 J K−1). 

In the table below the graph the donor concentration ND is displayed per cm3: 

Donors/cm^3. 

 

 

46.  Crosshair indicator for data points in Result graph 

 

The measurement results are plotted real time the Result graph tab. An arrow at the top 

of the graph indicates the position on the x-axis of the latest data point.  

 

When the mouse is pointed to any datapoint in the graph, during the measurement or 

after it has completed, a set of crosshairs appears to indicate the datapoint's position on 

both the x- and y-axes.  

Especially in multi-scan runs it is now easier to determine the position (and scan) of the 

selected datapoint. For each data point that is selected the key values are show, 

depending on the technique (i.e. the E and I values are shown for a CV, the Z1, Z2 and 

freq. are show in an EIS plot). 

 

   

47.  Mixed Mode skip to next level (2.662) 

 

During measurement in Mixed Mode, the scan can be forced to proceed to the next stage 

by pressing the 'Continue' button. The current stage is aborted (similar to a threshold 

being reached) by manual intervention of the operator. When the continue button is 

pressed at the last line, the scan is ended. 

 

 

48.  ChronoAmperometry/Chronopotentiometry skip to next level (2.673) 

 

During measurement in ChronoAmperometry/Chronopotentiometry, the scan can be 

forced to proceed to the next level by pressing the 'Continue' button. The current stage 

is aborted (similar to a threshold being reached) by manual intervention of the operator. 

When the continue button is pressed at the last line, the scan is ended. 
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49.  Mixed Mode: Absolute E/I end in sweep level (2.697) 

 

In the technique Mixed Mode stages window, 5 control modes are possible: 

 

¶ E control (potentiostatic) 

¶ I control (galvanostatic) 

¶ Open cell 

¶ Z control (rheostatic) 

¶ P control (constant power) 
 

For the E, I, Z and P levels the applied value can be chosen in the Level properties to the 

right hand side of the window.  

 

 
 

Checking the box 'X vs Xprev' will use the last measured value of that parameter in the 

previous level (E in the figure above) as a reference for 'X applied' rather than the 

absolute value; in the figure above the 'E applied' will be: 0.5V + [last measured E value 

of the previous level]. 

  

In addition the user can choose to create a sweep level rather than a constant applied 

value, by checking the box '+SweepX'. The sweep will start at 'X applied' and end at 'X 

end' with selected 'scanrate'. When 'X vs Xprev' is checked the 'X end' will automatically 

also be applied with reference to the last measured value of the previous level. 

 

Now it is also possible for E and I controlled levels to sweep from a relative 'X applied' to 

an absolute 'X end': by checking the box 'Absolute X end'. In the figure above a sweep 

will be done from 0.5V relative to the last measured voltage of the previous level, to an 

absolute end voltage of 1V. 
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